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Lesson 1
Geometric Construction Basics

FeaininglObjeEtives

¢ Create and Save AutoCAD Drawing Files

¢ Use the AutoCAD LT Visual Reference
Commands

¢ Draw, Using the LINE and CIRCLE
Commands

¢ Use the ERASE Command

¢ Define Positions Using the Basic Entry
Methods

¢ Use the Pan Realtime Option
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Introduction

Learning to use a CAD system is similar to learning a new language. We need to begin
with the basic alphabet and learn how to use the basic alphabet correctly and effectively
through practice. This will require learning some new concepts and skills as well as
learning a different vocabulary. All CAD systems create designs using basic geometric
entities. Most of the constructions used in technical designs are based upon two-
dimensional planar geometry. The method and number of operations that are required
to accomplish the construction are different from one system to another.

In order to become effective in using a CAD system, we must learn to create geometric
entities quickly and accurately. In learning to use a CAD system, lines and circles are the
first two, and perhaps the most important two, geometric entities that we need to master
the skills in creating and modifying. Straight lines and circles are used in almost all
technical designs. In examining the different types of planar geometric entities, we can
see that triangles and polygons are planar figures bounded by straight lines. Ellipses and
splines can be constructed by connecting arcs with different radii. As we gain some
experience in creating lines and circles, similar procedures can be applied to create other
geometric entities. In this lesson, we will examine the different ways of creating lines and
circles in AutoCAD LT® 2009.

Starting Up AutoCAD LT 2009

1. Select the AutoCAD LT 2009 option on the Program menu or select the
AutoCAD LT 2009 icon on the Desktop. Once the program is loaded into
memory, the AutoCAD LT 2009 drawing screen will appear on the screen.

1515 Faint 1% Set Program Access and Defaults
(3 RagDollkngFu & Windows Catalog

B putocAD LT 20 @ Windows Update

@ Accessaries 4

G nutodesk ) AutocaD 2009 ’

7] Games ¥ | ACEMYiew 2009 v

@ Skartup 3 I@ Autodesk Inventor 2009 4

I WinRAR b I DWG Trustiew 2009 » |7 Migrate Custom Settings
@ Internet Explorer I@ Autodesk Data Management ¥ U attach Digital Signatures
[‘ﬁ] Cutlook Express & Autodesk Design Review 2009 T

- Remate Assistance fi BUboCAD LT 2009 ] @ Portable Litense Utilicy

@ Windows Media Player
Al Programs : :
ﬁ Windows Messenger

Log OFf E Turn OFf Computer

ﬂ,-' Start @ [ I} Internet




Geometric Construction Basics 1-3

» Note that AutoCAD LT automatically assigns generic names, Drawing X, as new
drawings are created. In our example, AutoCAD LT opened the graphics window
using the default system units and assigned the drawing name Drawing].

[ =N = ..-. AutoCAD LT 2009 Drawingl.dwg [l T vpe & keyword or phrase
I BodsaReferences  Amnotate  Took  View  Oulput a

Layers

Comwand: _RIBBECON
Command: COMHANDLINE

4 13
[l & )]« [=]+]e] [ ] ] ] P e ]

Command :

Drawing Units Setup

Every object we construct in a CAD system is measured in units. We should determine
the value of the units within the CAD system before creating the first geometric entities.

1. Inthe Menu Browser, select:
[Format] - [Units]

Eile Layer...

Edit % Layer States Manager...
View I Layer tools
Insert O Color...
Format > Linetype...
Tools Lineweight...
Draw At Scale List...
Dimension &g Text Style...
Modify %, Dimension Style...
Window 5 Table style...
Help ﬁ Multileader Style

¥ Plot Style..

[ Boint Style...

X Units...

Drawing
Units...
dE Controls coordina
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2. Inthe Drawing Units dialog box, set the Length Type to Decimal. This will set
the measurement to the default English units, inches.

[ ¥ Drawing Units El

— Length —Angle
Type: Type:

I Decimal - I I Decimal Degrees - I
Precizion: Precizion;

0.00 =l{ {Jo =
1]
0.0 [T Clockwize

—{0.000 %

0.0000
0.00000
0.000000
0.0000000
[ 0.00000000

S ample Cutput

3. Set the Precision to two digits after the decimal point as shown in the above
figure.

4. Pick OK to exit the Drawing Units dialog box.

Drawing Area Setup

Next, we will set up the Drawing Limits; setting the Drawing Limits controls the
extents of the display of the grid. It also serves as a visual reference that marks the
working area. It can also be used to prevent construction outside the grid limits and as a
plot option that defines an area to be plotted/printed. Note that this setting does not limit
the region for geometry construction.

1. In the Menu Browser, select:

File Layer... [ ] [ . P ]
o 2 vy st e - Format] - [Drawing Limits
Wiew I Layer tools
Insert @ Color...
Format » Linetype...
Tools Lineweight...
Draw At Scale List...
Dimension && Text Style...
Madify % Dimension Styl...
Window G) Table Style...
Help /5 Multileader Style
S Plot Style...
T Eoint Style...
X Units...
Drawing IJ;rKiis
[[1] Rename... "
Drawing Limits
Sets and controls the limits of the grid

Layout tab

[ LIMITS

Recent Documents
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2. Inthe command prompt area, near the bottom of the AutoCAD LT drawing screen,
the message “Reset Model Space Limits: Specify lower left corner or [On/Off]
<0.00,0.00>:” is displayed. Press the Enter key once to accept the default
coordinates <0.00,0.00>.

Comgand: ' limits
Fezget Model space limits:

Specify lower left corner or [ON/OFF] <0.00,0.00>:

3. In the command prompt area, the message “Specify upper right corner
<12.00,9.00>:” is displayed. Press the ENTER key again to accept the default
coordinates <12.00,9.00>.

Fezset HModel space limits:
Gpecify lower left corner or [ON/SOFF] <0.00,0.00x:

Specify upper right corner <12.00,9.00>:

i EL @

4. On your own, move the graphic cursor near the upper-right comer inside the
drawing area and note that the drawing area is unchanged. (The Drawing Limits
command is used to set the drawing area; but the display will not be adjusted until
a display command is used.)

5. Inthe Menu Browser, select:
[View] 2 [Zoom] - [All]

' e AutoCAD LT 2009 BB
Search menu EY Pt
File ¥ Redraw
Edit Regen
Wisw > Regen All
Insert 4 Zoom
Format Q Realtime
Tools
- Q Previous
Drraw
@ Window
Dimension Q Dynami
amic
Modify -
) & scle
Window
' @ Center
Hel
bep @ Object
& In
Q Out
O Al [%
&), Extents
[ Ean All
T Zooms to display the drawing extents or the grid limits
@ steering | ZOOM
Recent Documents
&1 R [?] Press F1 for more help |
Open Doguments

+ The Zoom All command will adjust the display so that all objects in the drawing are
displayed to be as large as possible. If no objects are constructed, the Drawing Limits
are used to adjust the current viewport.
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Using the InfoCenter to Get More Information

Prior to creating geometric objects, let’s examine the usage of the InfoCenter option to
obtain some help on the subject.

Draw lines

1. Type Draw lines in the /nfoCenter input box
to search for any Draw related information.

‘s Guide
ﬁm? metric Objects 2. Click Draw Geometric Objects in the
@ Create AutoCAD LT Help list as shown.

raw lines
i Notes 8| gescription: Draw Gaomstric Objects
User's Guide

&l To creal

oCEdUrE Create and Modify Objects >

Draw Geometric Objects

3. Inthe AutoCAD LT 2009 User’s Guide,

general information regarding the Chpeces by Spoye parts it e petina ce or by
. . . entering coordinate walues at the command prompt.
constructions of geometric objects are
You can create a range of objects, from simple lines and
descrlbed circles to spline curves, and ellipses. In general, you draw

objects by specifying points with the pointing device or by
entering coordinate walues at the command prompt.

Topics in this section

4. Click Draw Linear Objects to get more
. . . = Draw Lineg\'ﬁ Objects
lnformatlon On hOW tO ConStrUCt Llnear A line, the niost basic object, can be one segment or a

series of connected segments.

Objects. e

= Draw Curved Objects

Curved cbijects are arcs, circles, polvline arcs, donuts

Commands = L commands > LINE >

LINE

Concept Procedure Quick Reference

5. On your own, click Draw Lines and then
Line to view the description of the
AutoCAD LT Line command.

Creates straight line segments

8 Ribbon: Home tab » Draw panel » Lme./

8 Toolbar: Draw /
8 Menu: ‘ »Draw » Line

EE command entry: line

e On your own, read through the descriptions
listed in Concepts. Procedure and Quick
Reference.

Soecify firsit point: Specify a point or press ENTER to

Drawing Lines with the Line Command

1. Move the graphics cursor to the first icon in
the 2D Draw and modify panel. This icon is
the Line icon. A help-tip box appears next to

the cursor.
Line . oo .
Creates straight ine seqments 2. Select the icon by clicking once with the left-
= LINE mouse-button, which will activate the Line

command.
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3. Inthe command prompt area, near the bottom of the AutoCAD drawing screen,
the message “ line Specify first point.” is displayed. AutoCAD expects us to
identify the starting location of a straight line. Move the graphics cursor inside the
graphics window and watch the display of the coordinates of the graphics cursor
at the bottom of the AutoCAD drawing screen. The two numbers represent the
location of the cursor in the X and Y directions. We can treat the graphics window
as if it was a piece of paper and we are using the graphics cursor as if it were a
pencil with which to draw.

R

it

Coordinates of the location
of the graphics cursor.

= Specify lower left corner
Specify upper right corne

Cortosrid

s We will create a freehand sketch of a five-
point star using the Line command. Do not
be overly concerned with the actual size or
the accuracy of your freehand sketch. This
exercise is to give you a feel for the
AutoCAD® LT 2009 user interface.

4. We will start at a location near the
bottom of the graphics window.
Left-click once to position the
starting point of our first line.

hid Specify First point: | 2.3

+¢ The two numbers, displayed next to the cursor, represent the current cursor position.
Note that the same two numbers are also displayed at the lower left corner of the
AutoCAD main window. The displaying of tooltips is known as the Dynamic Input
option. Tooltips are displayed near the cursor, which are dynamically updated as the
cursor moves.
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5. Next move the cursor upward
and toward the right side of
point 1. Notice the rubber-
band line that follows the
graphics cursor in the graphics
window. Left-click again
(point 2) and we have created
the first line

i of our sketch.

‘ | Specify next point of @l

42

e The two numbers, displayed
next to the cursor, represent
the distance and angle of the
current cursor position
relative to the previously
selected location on the
screen. This feature is also
part of the Dynamic Input
option. A more detailed
discussion on how to utilize
this feature is presented in
Chapter 3 of this text.

...... | ~......J§ 6. Move the cursor to the left

: of point 2 and create a
horizontal line roughly about
the same length as the first
line on the screen.

| [Palar: 4.12 < 150 |
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7. Repeat the above steps and complete
the freehand sketch by adding three
more lines (from point 3 to point 4,
point 4 to point 5, and then connect to
point 5 back to point I).

Zancel !

8. Notice that the Line command remains activated even

, .
Recent Inpt after we connected the last segment of the line to the

Close starting point (point 1) of our sketch. Inside the graphics
Undo window, click once with the right-mouse-button and a
popup menu appears on the screen.
Snap Cwertides r
5 Pan 9. Select Enter with the left-mouse-button to end the Line
Q, Zoom command. (This is equivalent to hitting the [ENTER] key
(i) Steeringyhesls on the keyboard.)
CuickiCale
10. On your own, move the
L cursor near point 2 and
point 3, and estimate the
T length of the horizontal
line by watching the

displayed coordinates
for each point at the
bottom of the screen.
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Visual Reference

The method we just used to create the freehand sketch is known as the interactive
method, where we use the cursor to specify locations on the screen. This method is
perhaps the fastest way to specify locations on the screen. However, it is rather difficult
to try to create a line of a specific length by watching the displayed coordinates. It
would be helpful to know what one-inch or one-meter looks like on the screen while
we are creating entities. AutoCAD® LT 2009 provides us with many tools to aid the
construction of our designs. We will use the GRID and SNAP options to get a visual
reference as to the size of objects and learn to restrict the movement of the cursor to

a set increment on the screen.

The Status Bar area is located at the bottom of the AutoCAD LT drawing screen. The
words SNAP, GRID, ORTHO, POLAR, OSNAP,OTRACK, DYN, LWT and MODEL
appearing to the right of the coordinates are buttons that we can left-click to turn these
special options ON and OFF. When the corresponding button is highlighted, the specific
option is turned on. These buttons act as toggle switches; each click of the button will
toggle the option on or off. Using the buttons is a quick and easy way to make changes
to these drawing aid options. We can toggle the options ON and OFF in the middle of
another command.

GRID ON

“F 3pecify next point or [Close/Undo] :
Specify next point or [Close/Tndo] : Option Buttons

Corenand:

1. Left-click the GRID button in the Status Bar to turn ON the GRID option. (Notice
in the command prompt area, the message “<Grid on>" is also displayed.)

Cormtoatd: <zrid on>

Cormtoatd:

Grid Display

2. Move the cursor inside the graphics window, and estimate the distance between
the grid points by watching the coordinates display at the bottom of the screen.

e i

"M gpecify next point or [Close/ = 3pecify next point or [Closef
Command: <Grid onx Command: <Grid on:

Cormmand : Cormmand :
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%+ The GRID option creates a pattern
of dots that extends over an area on
the screen. Using the grid is similar
to placing a sheet of grid paper under
a drawing. The grid helps you align
objects and visualize the distance
between them. The grid is not
displayed in the plotted drawing. The
default grid spacing, which means the
distance in between two dots on the
screen, is 0.5 inches. We can see that
the sketched horizontal line in the
above sketch is about 5.5 inches long.

Dynamic Input OFF
1. Left-click the Dynamic Input button in the Status Bar to turn OFF the Dynamic
Input option.
L.Tl;lr.t”[mand:

Cortoand:

Dynamic Input

» The Dynamic Input button allows the quick toggle of the Dynamic Input option.
We will switch off this option to discuss the basic input options available in
AutoCAD LT. A more detailed discussion on this feature is presented in Chapter 2.

SNAP ON

1. Left-click the SNAP button in the Status Bar to turn ON the SNAP option.

.

Corenand :

Corinard

JBL]e [ ][=[+]E
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2. Move the cursor inside the graphics window, and move the cursor diagonally
on the screen. Observe the movement of the cursor and watch the coordinates
display at the bottom of the screen.

» The SNAP option controls an invisible rectangular grid that restricts cursor
movement to specified intervals. When SNAP mode is on, the screen cursor and
all input coordinates are snapped to the nearest point on the grid. The default snap
interval is 0.5 inches, and aligned to the grid points on the screen.

/ J,,.n N, G | 3. Click on the Line icon in the Draw toolbar.

In the command prompt area, the message
“ line Specify first point: " is displayed.

4. Create another sketch of the five-point star with the GRID and SNAP options
switched ON.

Specify next point or [Close/Undo] :
Specify next point or [CloSe/Undo]:

Comtnand:

Cancel !

Recent Inpuk L4

5. Use the right-mouse-button and select Enter in the popup
menu to end the Line command if you have not done so.

Close
Undo

Snap Owerrides k
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Using the ERASER

One of the advantages of using a CAD system is the ability to remove entities without
leaving any marks. We will erase two of the lines using the Erase command.

1. Pick Erase in the Modify toolbar. (The
icon is the first icon in the Modify
toolbar. The icon is a picture of an
eraser at the end of a pencil.) The
message “Select objects” is displayed
in the command prompt area and
AutoCAD LT waits for us to select the
objects to erase.

A, BO0 Eleh B
te ©
| %ﬁﬂ +~/ 1+ 13

Erase

Removes objects from a drawing

| i ERASE

2. Left-click the SNAP button on the Status Bar to turn OFF the SNAP option so
that we can more easily move the cursor on top of objects. We can toggle the
Status Bar options ON or OFF in the middle of another command.

3. Select any two lines on the screen.

Select objects:

4. Right-mouse-click once to accept the selections. The selected two lines
are erased.
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Repeat the Last Command

@ SteetingWheels

Recent Input ! L4
o Cut Chrls
([ gopy Ctr+C
rl‘:‘._ Copy with Base Point ChrlH-Shift+C
[T past= Chrl+y
55| Paste as Block CEr{+-Shift+!
,m Paste to Original Coordinates
A Unda Erase
= Redo Chrby
& Pan
Q ZLoamm

Inside the graphics window, click once with the
right-mouse-button to bring up the popup option
menu.

Pick Repeat Erase, with the left-mouse-button, in
the popup menu to repeat the last command. Notice
the other options available in the popup menu.

AutoCAD LT® 2009 offers many options to assist
us in accomplishing this task. Throughout this text,
we will emphasize the use of the AutoCAD Heads-
up Design™ interface, which means that we can
focus on the screen, not on the keyboard.

3. Move the cursor to a location that is above and toward the left side of the entities
on the screen. Left-mouse-click once to start a corner of a rubber-band window.

s

First corner

Second corner

4. Move the cursor toward the right and below the entities, and then left-mouse-click
to enclose all the entities inside the selection window. Notice all entities that are
inside the window are selected.

5. Inside the graphics window, right-mouse-click to proceed with erasing the
selected entities.

» On your own, create a sketch of your choice using the Line command. Experiment
with using the different commands we have discussed so far, such as switching the
GRID and SNAP options ON and OFF in the middle of a command.
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The CAD Database and the User Coordinate System

¢ Designs and drawings created in a CAD system are
usually defined and stored using sets of points in
what is called world space. In most CAD systems,
the world space is defined using a three-dimensional
Cartesian coordinate system. Three mutually
perpendicular axes, usually referred to as the X, Y
and Z-axes, define this system. The intersection of
the three coordinate axes forms a point called the
origin. Any point in world space can then be defined
as the distance from the origin in the X, Y and
Z- directions. In most CAD systems, the directions
of the arrows shown on the axes identify the positive
sides of the coordinates.

A CAD file, which is the electronic version of the design, contains data that describe the
entities created in the CAD system. Information such as the coordinate values in world
space for all endpoints, center points, etc., along with the descriptions of the types of
entities is all stored in the file. Knowing that AutoCAD LT stores designs

by keeping coordinate data helps us understand the inputs required to create entities.

3D UCS icon

AﬁElEu:t Dl:ujec;f: Specify opposite corner: &
Select obdfcts:

Cortoand:

The icon near the bottom left corner of the default AutoCAD LT graphics window shows
the positive X-direction and positive Y-direction of the coordinate system

that is active. In AutoCAD LT, the coordinate system that is used to create entities is
called the User Coordinate System (UCS). By default, the User Coordinate System is
aligned to the world coordinate system (WCS). The world coordinate system is a
coordinate system used by AutoCAD LT as the basis for defining all objects and other
coordinate systems defined by the users. We can think of the origin of the world
coordinate system as a fixed point being used as a reference for all measurements. The
default orientation of the Z-axis can be considered as positive values in front of the
monitor and negative values inside the monitor.
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Changing to the 2D UCS Icon Display

In AutoCAD® LT 2009, the UCS icon is displayed in various ways to help us visualize

€ <

the orientation of the drawing plane.

&
1 [

20 UCE st right side view

WS af 20 UCS

% z
l—b‘r’ l—b“r’
D UCEat  right side view
WICS of 30 UCS

@ SteeringWheels
Format Aerial View

Clean Scresn Ctri+0

I Viewports
2 Named Views...
I 3D Views

Show Annotative Objects

(3 Hide
I

Shade

4 Display
4 UCS Icon
& on
@ Origin
B rties...

&1 Recent Documents

[E Open Documents
5‘ Recent Actions

Controls the style, size and color of the UCS icon

[?7] Press F1 for more help

2. Inthe UCS icon style section,

switch to the 2D option as shown.

3. Click OK to accept the settings.

% Note the W symbol in the UCS
icon indicates the UCS is aligned
to the world coordinate system.

=0 wiew of 20 UCS viewed
20 UCs from bhelaow
7 7
f |
I
bt
iz0 wiew of 30 UCS viewed
ab Cs from bhelaow

1. In the Menu Browser, select:
[View] - [Display] =
[UCSIcon] - [Properties]

[ JUCS Icon

— UCS icon style
@« 20
3

¥ | Care
s PON

Preview

Line width: I R l

—

rUCSiconsize——————————
— 2

I

r~ UCS icon color

todel space

ican colar: Layout tab icon colar:

[ Black

j I. Blue j

QK I Cancel | Help |




Geometric Construction Basics 1-17

Cartesian and Polar Coordinate Systems

In two-dimensional space, a point can be represented using different coordinate systems.
The point can be located, using Cartesian coordinate system, as X and Y units away from
the origin. The same point can also be located using the polar coordinate system, as r and
0 units away from the origin.

tH

For planar geometry, the polar coordinate system is very useful for certain applications.
In the polar coordinate system, points are defined in terms of a radial distance, r, from the
origin and an angle, 0, between the direction of r and the positive X-axis. The default
system for measuring angles in AutoCAD® LT 2009 defines positive angular values as
counter-clockwise from the positive X-axis.

Absolute and Relative Coordinates

LN AutoCAD LT® 2009 also allows us to use absolute
Il _ S _ and relative coordinates to quickly construct objects.
3> Absolute coordinate values are measured from the
e —— current coordinate system's origin point. Relative
- |Command: _ucsicon coordinate values are specified in relation to previous

Ent 1 on )
nter an option [ coordinates.

Cortosid

Zi|EIL_N > The coordinate display area can also be used as a
toggle switch; each left-mouse-click will toggle the
coordinate display on or off.

Drawing Coocrdinates

In AutoCAD LT® 2009, the absolute coordinates and the relative coordinates can

be used in conjunction with the Cartesian and polar coordinate systems. By default,
AutoCAD LT expects us to enter values in absolute Cartesian coordinates, distances
measured from the current coordinate system's origin point. We can switch to using

the relative coordinates by using the @ symbol. The @ symbol is used as the relative
coordinates specifier, which means that we can specify the position of a point in relation
to the previous point.
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Defining Positions

In AutoCAD LT, there are five methods to specify the locations of points when we create
planar geometric entities.

> Interactive method: Use the cursor to select on the screen.

» Absolute coordinates (Format: X,Y): Type the X and Y coordinates to locate the
point on the current coordinate system relative to the origin.

> Relative rectangular coordinates (Format: @X,Y): Type the X and Y coordinates
relative to the last point.

> Relative polar coordinates (Format: @distance<angle): Type a distance and angle
relative to the last point.

> Direct distance entry technique: Specify a second point by first moving the cursor
to indicate direction and then entering a distance.

The Guide Plate

We will next create a mechanical design using the different coordinate entry methods.
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The rule for creating CAD designs and drawings is that they should be created full size
using real-world units. The CAD database contains all the definitions of the geometric
entities and the design is considered as a virtual, full-sized object. Only when a printer
or plotter transfers the CAD design to paper is the design scaled to fit on a sheet. The
tedious task of determining a scale factor so that the design will fit on a sheet of paper
is taken care of by the CAD system. This allows the designers and CAD operators to
concentrate their attention on the more important issues — the design.

(o LINE

Creates straight line segments |

| [?] Press F1 for more help

1.

Select the Line command icon in the Draw
toolbar. In the command prompt area, near the
bottom of the AutoCAD LT graphics window,
the message “ line Specify first point:” is
displayed. AutoCAD LT expects us to identify
the starting location of a straight line.

In the command prompt area, we will locate
the starting point of our design at the origin of
the world coordinate system. Command.: _line
Specify first point: 0,0 [ENTER] (Type 0,0
in the command prompt area and press the
[ENTER] key once.)

3. We will create a horizontal line by entering the absolute coordinates of the second
point. Specify next point or [Undo]: 5.5,0 [ENTER]

0

(5.5,0)

¥ Command: line Specify first point: 0,0
Specify next point or [Undo]:

5.5,0

.~ Specify next point or [Undo]:

The line we created is aligned to the bottom edge of the drawing window.
Let us adjust the viewing of the line by using the Pan Realtime command.
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4. Click on the Pan Realtime icon in the Quick Access toolbar panel at the bottom
of the main AutoCAD window. The icon is the picture of a hand with four arrows.

1B BN QAL e

Pan

®,

+ The Pan command enables us to move the view to a different position. This
function acts as if you are using a video camera.

5. Move the cursor, which appears as a hand inside the graphics window, near the
center of the drawing window, then push down the left-mouse-button and drag the
display toward the right and top side until we can see the sketched line. (Notice
the scroll bars can also be used to adjust viewing of the display.)

6. Press the [Esc] key to exit the Pan command. Notice that AutoCAD LT goes
back to the Line command.

7. We will create a vertical line by using the relative rectangular coordinates entry
method, relative to the last point we specified

Specify next point or [Close/Undo]: @0,2.5 [ENTER]

8. We can mix any of the entry methods in positioning the location of an endpoint.
Move the cursor to the Status Bar area, and turn ON the GRID and SNAP options.

|
<3nap onx

Specify next-poine or [Cloze/Undo] :

L]

il & || = |+
SNAP & GRID ON

9. Create the next line by picking the location, world
coordinates (8,2.5), on the screen.

FSpecify next p
Specify next p

Specify next p

10. We will next use the relative polar coordinates entry method, relative to the last
point we specified.

Specify next point or [Close/Undo]: @3<90 [ENTER]
(Distance is 3 inches and an angle of 90 degrees)



Geometric Construction Basics 1-21

11. Using the relative rectangular

} coordinates entry method to
L-m _ _ create the next line, we can
L _ o _ o _ _ imagine a reference coordinate
Reference Coordinate system aligned at the previous
System aligned at the : : : point. Coordinates are measured
previous point along the two reference axes.

Specify next point or [Close/Undo] :
@-1.5,1 [ENTER]

(-1.5 and 1 inches are measured
relative to the reference point.)

12. Move the cursor directly to the left of
the last point and use the direct

distance entry technique by entering
6.5 [ENTER].

point or [Close/Undo]: B3<90
point or [Close/Undo]: B-1.5,1

point or [Close/Tndo] :

Enter

Eancel 13. For the last segment of the sketch, we can use the Close
- option to connect back to the starting point. Inside the
Recent Input k

graphics window, right-mouse-click and a popup menu

m appears on the screen.
u

ndo
14. Select Close with the left-mouse-button to connect back
Snap Oyerrides  * to the starting point and end the Line command.
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Creating Circles

The menus and toolbars in AutoCAD® LT 2009 are designed to allow the CAD
operators to quickly activate the desired commands. Besides using the Draw toolbar,
we can also select the different Draw commands through the Menu Browser.

1. In the Draw toolbar, click on the little triangle next to
the circle icon. Note that the little triangle indicates
additional options are available.

o @v _/_ﬁ[] | = ﬂ'm &
Qi

@ Center, Diameter
O 2-Paint Center, Diameter

Creates a circle using a specified diameter
Q 3-Paint : CIRCLE

[?] press F1 for more help ‘ )
@ Tan, Tan, Radms

O Tan, Tan, Tan

¢ Notice the different options available under the circle submenu:

e Center Point: Draws a circle based on a center point and a diameter or a radius.
e 3 Points: Draws a circle based on three points on the circumference.

e 2 Points: Draws a circle based on two endpoints of the diameter.

e TTR - Tangent, Tangent, Radius: Draws a circle with a specified radius tangent
to two objects.

e TTT- Tangent, Tangent, Tangent: Draws a circle tangent to three objects.
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3. Inthe command prompt area, the message “Specify center point for circle or
[3P/2P/Ttr (tan tan radius)]: " is displayed. AutoCAD LT expects us to identify
the location of a point or enter an option. We can use any of the four coordinate
entry methods to identify the desired location. We will enter the world
coordinates (2.5,3) as the center point for the first circle.

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 2.5,3 [ENTER]

4. In the command prompt area, the message “Specify diameter of circle:” is
displayed.

Specify diameter of circle: 2.5 [ENTER]

.

5. Inside the graphics window, right-
Recent In 3 mouse-click to bring up the popup

option menu.

S cut Chel4+

[ copy Chrl+C 6. Pick Repeat Center, Diameter with
[0, Capy with Base Paint Ctrl+Shift+C the left-mouse-button in the popup menu
T4 paste Chrl4+y to repeat the last command.

L3l Paste as Black Chel+Shift-+y

7. Using the relative rectangular
coordinates entry method, relative to the

& undo Circle center-point coordinates of the first

circle, we specify the location as (2.5,2).

xm Faste to Driginal Coordinates

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: @2.5,2 [ENTER]
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8. In the command prompt area, the message “Specify Radius of circle: <2.50>" is
displayed. The default option for the Circle command in AutoCAD LT is to specify
the radius, and the last radius used is also displayed in brackets.

Specify Radius of circle<l.25>: 0.75 [ENTER]

Saving the CAD File

>

I Search menu

1.

Filz:

Edit
Wisw
Insert
Format
Tools
Draw
Dimension
Modify
Window
Help

> [f New.. Cirl+N =
Mew Sheet Set...
= Open... Ctr+0
Open Shest S=t...
Q Load Markup S=t...
Close
Partial Load

Import...

EHl save Cirl+5
Save As. Crl+Shift+5

[9 eIransml%

= : Save As... (Ctrl+Shift+5)

In the Menu Browser, select:
[File] > [Save As]
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2. Inthe Save Drawing As dialog box, select the folder in which you want to store
the CAD file and enter GuidePlate in the File name box.

L 5ave Drawing As ﬂ
Save in: IEI-""‘E'&D Projects j @ W@ X Vews v Took v
A :
Mame = \ | Size | AT

\ Select the folder to
store the file

My Dacuments

1] | Enter GuidePlate

[ Update sHget and wiew thumbnailz now

File narme: IGUidEPl j &l
Files af type: I.f-\utnCAD LT 2007/AutaCAD 2007 Drawing [*.dwal | ﬂl

3. Pick Save in the Save Drawing As dialog box to accept the selections and save
the file.

Exit AutoCAD LT 2009

—— % To exit AutoCAD® LT 2009, select
= Qper. : File then choose EXit from the pull-

23] Load Markup Set...

Close down menu or type QUIT at the

Impot... command prompt.
H save
Save ... Ctrl+shift+5
Dimension Q eTransmit...
Modify @ Publish to Web...
Window B Export...
Help Bl Export Layout to Model...

E%] Page Satup Manager...

FEI Plotter Manager...

@ Plot Style Manager...

[ mlot Preview

= Plot...

&) Publish...

f& View Plot and Publish Details...
53 Recent Documents Drawing Utilities
[ Open Documents send...
& Recent Actions ﬁ_:' Drawing Properties...
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Review Questions:

1. What are the advantages and disadvantages of using CAD systems to create
engineering drawings?

2. What is the default AutoCAD LT filename extension?
3. How do the GRID and SNAP options assist us in sketching?
4. List and describe the different coordinate entry methods available in AutoCAD LT.

5. When using the Line command, which option allows us to quickly create a line-
segment connecting back to the starting point?

6. List and describe the two types of coordinate systems commonly used for planar
geometry.

7. Which key do you use to quickly cancel a command?
8. When you use the Pan command, does the coordinates of objects get changed?
9. Find information on how to draw ellipses in AutoCAD LT through the InfoCenter

and create the following arc. If it is desired to position the center of the ellipse to a
specific location, which ellipse commands is more suitable?

. | 5 —-

- *
1.0
| {

10. Find information on how to draw arcs in AutoCAD LT through the InfoCenter and
create the following arc. List and describe two methods to create arcs in AutoCAD

N

207

2.5 :



Geometric Construction Basics

1-27

Exercises: (All dimensions are in inches.)

1.
’_7 1.00 a‘—— 0,75 —m
|
2.00
e * 150
050
{ 1
025 r
{ - 225 -
- 3.00 -
2.
- 4,235 -

= 1,00 =

1,00
\( ©1.00

N

L.30
@e.00

- 200 -
- 2.2l -
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3.
6,50
~—1.50 3,50
1.00 - — 1.00 g
4.00
J N
175 ——‘
Vs
- 4,75 -
4.
1,25 |
= 1,25
N | \
45t 0.20 45"
i {
o B 0125 /
1.23 075 jot— 1,220 —f 01.50
050
_r 0123 \
f T 0,375
05 . 0,20 .
& e 43 '* q45°
. o.as»‘ "
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